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Target Audience and Prerequisites

Target Audience

Welcome to the Q360 Help Center

« Management roles responsible for effective
and profitable business functions:
Executives, Sales, Operations, Projects,
Procurement, Service, Accounting

* Q360 users interested in the Forecasting
capabilities of the One Dashboard

Prerequisites / Optional Related MasterClasses:

Upcoming live webinar:

. One Dashboard I v24.01 (Feb 19, 2025) CrEeE i W e o
=3
 One Dashboard II v24.01 (Mar 23, 2025)
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Learning Objectives

By the end of this session, you will be able to:

« Recognize data trends reflected in the One Dashboard

 Examine your revenue and profit projections using the Break Even
Forecast

« Examine your Cash Forecast and drivers to understand Fixed and
Variable costs

« Perform "What If" scenarios to facilitate business decisions, i.e.
Sales Opportunities
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Agenda

1. Introduction
2. One Dashboard Meetings

a) Purpose
b) Timing
c) Agenda
3. One Dashboard Sample Views

4. Typical Scenarios
a) Bubble
b) Forecast will achieve Target
c) Profit Does Not Achieve Plan (Backlog Only, w / Opps)
d) Excessive Profit (Backlog Only, w / Opps)

5. Summary
6. Q&A
7. Wrap Up and References
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1. Introduction

« Purpose of the One Dashboard is to provide a single pane of glass
to forecast your financial performance

 One Dashboard simply shows you the financial performance of

your Company if you perform the work that you have scheduled
to perform

« Q360 is a workflow system - the data that you input (Quotes,

Labor scheduling, Purchasing, etc.) is used to provide a "big
picture”

SOLUTIONS - .- »

2025-04-23



2a. Purpose of One Dashboard Meeting

« If you plan your business, you can change your business
« Accurate forecasting allows your business to be more proactive

« By forecasting Revenue, Expenses, Net Profit, and Cash Flow, you can
affect profitability and liquidity

« Forecasting should be based on your plan, not just historical data

 The goal is not just to report on / explain the prior month, but to plan
and manage to intended results

« Good forecasting should not require any “extra” work to create and
maintain it — the One Dashboard is driven by staff performing their
day-to-day work

SOLUTIONS - - =
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2b. When / How to Use the One Dashboard

« It is a forecasting tool, so use it near the beginning of each month

« Give yourself time to change the plan to drive better results

« It is a Company view, not a Departmental view
« Review the One Dashboard as an Executive Team

« Have a common set of reports (and filters set in those reports) that
everyone has reviewed prior to the meeting

SOLUTIONS - .- »

2025-04-23 7 d Il1v24.01




2c. Typical One Dashboard Exec Meeting Agenda

First 10 Minutes: Review Previous Month L@@K
30-Day look back (typical financial review, close books in 3-5 business days) BACK
 Key Question: How did we do against our Plan?
Next 20 Minutes: One Dashboard Backlog Only
2. 3.4 MONTHS

30 / 60 / 90-Day Look Ahead SCHEDULE

« Key Output: What is our Plan? ~)
Next 20 Minutes: One Dashboard Backlog AND Sales Opportunities
« 3 to 6 Month Look Ahead "‘ T w
.- Key Output: What is our Plan? ‘H
Last 10 Minutes: Agree upon our Plan of Action ;;ﬁ ey
2‘7. \ODOLTST
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Poll #1: (Select all that apply)

What is your current forecasting / alignment situation?
a. We are a Sales-focused organization, and Operations just has to pick up the slack
b. We are ready for anything and pride ourselves on our quick reaction time

c. Because we are a Project-based business, we can't really predict anything after Projects
are created

d. Customers / Contractors constantly change their minds and schedules, so why plan?

e. We establish a plan at the start of the year, but don't know what to do when things go
awry

f. We use the One Dashboard to evaluate our data, plan our next steps and course correct
as needed

SOLUTIONS - .- »
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3. One Dashboard Views — Snapshot Project Forecast

* Snapshot is the “Project Revenue / Cost Forecast” at a point in time

« At the beginning of each month, save the Project Forecast Snapshot from
that month’s meeting

« This gives you the ability to look back and determine how you performed
against the plan

« Sort by missed revenue and look at the under / over amounts
« Learn how to forecast more accurately

. Rinse and repeat each month until you have confidence in the accuracy @@ K

of your planning
BACK

SOLUTIONS - .- »
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3. One Dashboard Views — Project Forecast Snapshot Eﬁgg

LIVE DATA: Project Forecast Snapshot Analysis JIXC]sJelgs\[eNOJ0CI0 L

Snapshot Date Forecast Period P.M. Project No. Title Type Snapshot Rev  ActualRev Rev% Delta Revenue Snapshot MatRev Actual Mat Rev Delta mat Rev Snapshot Hours Actual Hours Delta Hours
2024-03 (25)
2025-03-31 11:30PM  2025-03 LTHOMAS 480440 Executive Offices / Surveillance Can DES-BUILD $33,835.00 $31,743.28 93.818 $2,091.72 $19,293.86 $18,948.73 $345.13 124 225 -101
2025-03-31 11:30PM  2025-03 AGORDON 480214 Longhorn Foothall Facility DES-BUILD $31,580.00 $36,064.45  114.2 ($4,484.45) $19,055.79 $11,944.08 $7,111.71 136 232 -96
2025-03-31 11:30PM  2025-03 JGRAHAM 480298 Building Fire Alarm System and Ins|DES-BUILD $22,274.00 $21,003.81 94.297 $1,270.19 $14,853.14 $10,265.96 $4,587.18 129 216 -87
2025-03-31 11:30PM  2025-03 JGRAHAM 480429 Auditorium / Interactive Kiosk Integ DES-ONLY $29,722.00 $23,847.09 5§0.234 $5,874.91 $24,854.48 $11,835.12  $13,019.36 132 179 -47
2025-03-31 11:30PM  2025-03 JGRAHAM 480407 Building 5 / Surveillance Cameras M DES-ONLY $34,426.00 $31,117.07 90.388 $3,308.93 $12,131.12 $13,494.02 ($1,362.90) 133 154 21
2025-03-31 11:30PM  2025-03 LTHOMAS 480445 Entrance / Smart Lighting Security E DES-BUILD $29,593.00 $34,393.29 116.22 1$4,800.29) $14,634.90 $18,698.95 ($4.,064.05) 130 145 -15
2025-03-31 11:30PM  2025-03 JGRAHAM 479940 Cable Installation Only DES-BUILD $19,286.00 $15,659.50 §1.196 $3,626.50 $9,779.42 $8,137.08 $1,642.34 131 145 -14
2025-03-31 11:30PM  2025-03 JGRAHAM 387612 Cornerstone Call Center Implement DES-BUILD $18,486.00 $17,162.52 92.841 $1,323.48 $9,150.81 $11,838.14 ($2,687.33) 136 148 -12
2025-03-31 11:30PM  2025-03 KLANGSTROM 480439 Main Office / Biometric Scanner Sec DES-ONLY $31,106.00 $32,690.66 105.09 ($1,584.66) $11,625.85 $27,081.55  ($15,455.70) 132 142 -10
2025-03-31 11:30PM  2025-03 JGRAHAM 479957 Ashton - Mitel 3300 Install DES-BUILD $47,766.00 $54,282.69 113.64 ($6,516.69) $30,756.03 $30,355.13 $400.90 143 151 -8
2025-03-31 11:30PM  2025-03 JGRAHAM 479944 Cable Install - Rewire DES-BUILD $15,624.00 $13,552.63 86.742 $2,071.37 $5,542.77 $10,352.60 ($4,809.83) 139 144 ]
2025-03-31 11:30PM  2025-03 JMULDOON 480354 University Installation DES-BUILD $2,350.00  $2,110.12 89.792 $239.88 $1,459.66 $1,048.20 $411.45 134 131 3
2025-03-31 11:30PM  2025-03 KLANGSTROM 480405 Executive Offices / 55 Display Instal DES-ONLY $23,048.00 $25,734.26 11166 1$2,686.26) $18,047.97 $12,102.32 $5,945.65 125 120 5
2025-03-31 11:30PM  2025-03 JGRAHAM 479950 Cox Commm - Cable Install DES-BUILD $9,406.00  $7,938.05 84.393 $1,467.95 $4,560.88 $5,650.31 ($1,089.43) 134 128 6
2025-03-31 11:30PM  2025-03 TINDAWALA 450411 Hall3 / Smart Lighting Installation DES-ONLY $31,010.00 $29,613.42 95.496 $1,396.58 $19,232.54 $24,278.64 ($5,046.10) 134 121 13
2025-03-31 11:30PM  2025-03 AGORDON 480417 Lobby / Surveillance Cameras Syste DES-ONLY $36,396.00 $38,832.24 106.69 ($2,436.24) $30,524.55 $22,680.42 $7,844.13 129 116 13
2025-03-31 11:30PM  2025-03 KLANGSTROM 480281 Primex Integration Project DES-BUILD $2,771.00  $2,527.20 91.202 $243.80 $1,485.87 $1,215.45 $270.42 137 120 17
2025-03-31 11:30PM  2025-03 AGORDON 480446 Auditorium / Video Conferencing Se DES-BUILD $33,438.00 $32,772.59  98.01 $665.41 $27,263.41 $21,384.61 $5,878.80 132 114 18
2025-03-31 11:30PM  2025-03 RBURCHART 450418 Building 5 / 55 Display Maintenanct DES-ONLY $35,301.00 $39,082.82 110.71 ($3,781.82) $14,750.98 $32,143.68  ($17,392.70) 134 113 21
2025-03-31 11:30PM  2025-03 JGRAHAM 480394 2024 WBS Template DES-BUILD $15,675.00 $13,263.18 584.614 $2,411.82 $6,507.95 $8,252.07 1$1,744.12) 133 110 23
2025-03-31 11:30PM  2025-03 JGRAHAM 480421 Conference Room A/ Smart Lighting DES-ONLY $11,532.00 $10,998.93 95.377 $533.07 $7,226.57 $7,165.34 $61.23 136 92 44
2025-03-31 11:30PM  2025-03 JGRAHAM 480409 Auditorium / Fire Alarm System Cor DES-BUILD $17,800.00 $15,788.58 88.7 $2,011.42 $14,034.21 $7,031.63 $7,002.58 127 72 55
2025-03-31 11:30PM  2025-03 JGRAHAM 479970 Conference Room Refit DES-BUILD $8,712.00  $9,515.21 109.22 ($803.21) $5,689.81 $7,129.51 ($1,440.00) 130 70 60
ANIR N2 21 11-0N0M  ANIR N2 ML AAAM 400400 Cunmsitivin Méfinnn [ Annnnn Pandeal © NCE DTN ¢99 Joc nn | doneanca 117 07 e nac e ¢10 ncn A ¢12 410 o7 #4240 AC) 120 1R o7
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LOOK AHEAD

2. 3.4 MONTHS

3. One Dashboard Views — Backlog Only

12 Month Break Even Forecast

[ Total Revenue [RRN] Toial Cost [ ] Net Profit

Break Even Forecast

x ALL |

Company

# of Forecast [12
Periods

£ of Previous | 3
Periods

Fixed Periods To |7

Vg
Variable R
ariable ev:drjug |1I.'JD
Fixed Cost Adj % | 105

Base Currency |ALL

Time Units | Maonth

T
Min Probability
Cash Flow Forecast Summary

Incl. Proj. Invoices
Incl. Proj. Cost
Incl. 5.C. Invoices

Age By |AVG Pay Days
Periods to Collect |4

N

[
202505 2025-06 2025-07 2025-08 2025-09 2025-10 2025-11
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3. One Dashboard Views — Backlog and Opps

12 Month Break Even Forecast

[ Total Revenue [N Total Cost [ ] Net Profit

Break Even Forecast

= ALL

Company

# of Forecast |12
Periods

# of Previous |3
Periods

Fixed Periods To |7

vg
Varisble Revenue 100
Fixed Cost Adj % |105

Base Currency IALL

Time Units | Month

Include Opps |YES
Min Probability | 80|
Cash Flow Forecast §ummnry

Incl. Proj. Invoices

Incl. Proj. Cost
Incl. S.C. Invoices
Age By |ﬁwG Pay Days
Periods to Collect |4

Today
|
2025-04 202505 202506 2025-07 2025-08

|
2025-10

[
2025-11
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Poll #2: (Select all that apply)

How are you currently planning out next month's actions?

a. Gut feel - we've been doing this for so long, we just know what needs to be done
b. We ask for management input — each team decides what they need to do next
c. Historical trends — we compare last year's data to current data

d. One Dashboard - we use dashboard data to plan and manage to intended results

SOLUTIONS - - »
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4. Typical Scenarios

 Typical Executive reaction - "well, when it is right we will
look at it.”

« The reality is that unless you look at it, your team will never be
motivated to get it right

« Typical Organization reaction - "that would take too much
work to get right”
« It will not resolve itself, either you want the data in the system to

reflect the work you are performing, or you will not have the visibility
(forecast) you need to run your business

SOLUTIONS - .- »
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4a. Typical Scenarios

12 Month Break Even Forecast

Bubble - very typical starting
point

"] Total Revenue [ Total Cost [ | Net Profit

Caused by:

« Dates in the past - the
system puts them in the
current month

« Unscheduled Material and
Unscheduled Labor

 Flat lines show that J—/&

nothing has been I \/

scheduled into the future

Today

2025-03 202504 2025-05 2025-06 202507 202508 202509

2025-04-23 16 One Dashboard Il v24.01



4b. Typical Scenarios

Forecast will achieve target

12 Month Break Even Forecast

[ Total Revenue [ Total Cost [ Net Profit

What do we do now?

* Projected Profit and Cash Flow
are within target range

* Monitor throughout month,
but let teams simply execute

« Executive focus can be on
strategic initiatives

« No need to worry, stay awake I
at night, drill down,

. Today

mlcroma nage, etc 2025-03 2025-04 202505 2025-06 202507 2025-08 2025-09 202|5—10
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4c. Typical Scenarios

12 Month Break Even Forecast

Profit does not achieve plan ] otol Revenue. [ TotalCost. [ Net Prof
(backlog only)

What do we do now?

« Excess Labor Capacity

» Key question to address - is
there any work that can be
pulled into the planned
period?

Today

2025-03 202504 2025-05 2025-06 2025-07 2025-08

One Dashboard 111 v24.01
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4c. Typical Scenarios

Profit does not achieve plan
past current backlog

12 Month Break Even Forecast

[ Total Revenue [ Total Cost [ ] Net Profit

What do we do now?

« Insufficient sales

« Key question(s) to address

« Do we have a realistic plan
to achieve new orders to
meet our targets?

« Do we need to adjust our
spending?

2025-03 2025-05 2025-06 2025-07 2025-08 2025-09 2025-10 2025-11 202512

One Dashboard 111 v24.01
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4d. Typical Scenarios

Profit is excessive (backlog

O n I Y) 12 Month Break Even Forecast
[ Total Revenue [I Toial Cosi [ ] Net Profit

What do we do now?

« QOver-committed Labor

« Key question to address -
which work is going to be
pushed out?

« Prioritize work to company
objectives

« Communicate, communicate,
communicate Today
|

[
2025-03 2025-04 2025-05 2025-06 202507 2025-08 2025-09 2025-10
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4d. Typical Scenarios

Profit is excessive from future
sales

12 Month Break Even Forecast

[ Total Revenue [IINNN] Total Cost [T Net Profit

What do we do now?
« QOver-committed Sales

« Key question to address -
how do we prepare to fulfill
this work?

« Prioritize work to company
objectives

Today

« Communicate, communicate, ... - ios -y
communicate

|
202509 2025-10 2025-11

2025-12]
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Poll #3: (Select two)
My top two next steps are...

a. Establish a regular forecast meeting cadence

b. Ensure we regularly update data (Sales Opps, Labor, Material, and
Invoice Tasks)

c. Come prepared to speak to departmental data in the context of the
One Dashboard (hold each other accountable)

d. Review past 30 days and identify possible course corrections for next
30-60-90 days

e. Proactively plan for upcoming 3-6 months

SOLUTIONS - .- »
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5. Summary

 The data in the system is what your team is planning / working to
achieve

« One Dashboard is intended to help you move from data to foresight

« Once you have foresight, take the necessary action to drive the
results you desire

SOLUTIONS - .- »
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6. Q&A

2025-04-23 One Dashboard Il v24.01




Poll #4:

Would you like to be contacted regarding further training on maximizing
your Executive Team's ability to use the forecasting capabilities of
your One Dashboard?

a) Yes

b) No

2025-04-23 One Dashboard Il v24.01



/. Wrap Up & References

Q360 > Help > Contents

Q » Rl

Window [Wl

Send Email to Customer Care

[2) Sales Forecasting with Q360 v23.02

Sales Forecastng with Q30 VZ3.02
7 this MasterCIass webinar, we explore Sakes Farecazming meshodalogy and hunctcasity wein

2024 View or downlad sidc deck hore

Tri webinar was recorded on Msy 25,

1. Introcustion / Contese | 0208

between Roman Burchart anc Brad Makne

5 What co we sce mast aften?
2 Roks | 04:33

2 Sslos Reps

5 Ssles Engincers

€ Ssles Managers
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3. Motk Sales Msnsgement Meceing - Immaure (witn G360 cemo) | 07:20
4 Sales Opportunties - Key Opporunity Form Actribuees | 12:30

2 Interesr S3es Funnel > Saks Process.

1. {see also) Sals Funnel / Mark Compkeee
8 ssleType

c vaue

[£) Forecasting Reports in Q360 - Key Drivers

Contents

One Dashboard - Revenue and Cost Calculations

2 Edit  Editwith WPBakery Page Builder

360 provides many unigue forecasting repans to aid our o)
OpERItE IN 3 WICULM - shiy are driven by ggregate data o)
#arpcasting reparts and the key dama and processes that dr

Project Hours Schedule Summary (QO238)
+ Ohbjective: Review hours ¢ labor soid vs hours scheduled

ARCECTS to R they ane compiecely schedulnd.

+ Drivers/Seup:

+ Froject Task Scherule - ensure Estmated Effor and
+ Lrype rems on projects arder Inciuding ICOVCCD
+ Wihat o ook for?
#  Scheduled % < 805 ar whatewer your threshoid s
#  Eamid % =100, This indicates projects where acrual g

Froject Material Schedube Summary (J0288)

+ Objectiver Aeview oversl project marerial eqipmen: st
derrifying projects that may need an adustment 1o ther

»  DriversSetup:
®  Projecy Material Grid = Reguess Date. This & the dane
eoex
= Wihatta ook far?
#  Check prajects that have "Un-Scheduied” and "Overdug
® I therm ks Soid Subcomractor, | should be schiduled

& Checkforunder 206 scheduled and NOT S0 Sold Mate

Project Revenuse / Cost Forecast {Q0058)

+ Objective: Forecast averall project partfolio revenue and
»  DriverdSetup:
#  Projec Task Sthedule - ensure Esimated Effort and T
*  Frojecy Manerial Request Date

& Dpticrully, you may ineorporaee Sales Forecast inen th

Set PROJECTFORECASTMETHOD configuration “MATLAE
barsed an projecs lsbor and material plan. Ths, you m

Senvice Contract Revenue Forecast (0071}

+ Objective: To forecast Recurring Monehly Revenue This ri
- DriverfSetup:
» Aerive Service Coneract Start/End Date

+  Report will be based on Monchly revenue recogrison. |
per marh

2025-04

I3 Report: One Dashboard

Report & Q0284
One Dashboard

The One Dashboard is intended to give you visibility into the health and trajectory of your business and provide your team with the ability to plan
The One Dashboard provides accurate cash flow and cost forecasting to allow your business to be more proactive in your planning rather than rel
historical data.

The One Dashboard doss Rot require any ‘sxtra’ work in order to function - it simply pulls together your regular’ planning into one condensed fore
Break Even Forecast

The top graph of the One Dashboard, labeled “Break Even Forecast” (QU280), represents profitability - what the income statsment should look like,
previous periads {up to & manths) and forecasted into the futurs (up t2 24 monthe). The dashboard displays Total Revenue, Total Costs, and Net Pl

data point can be expanded to s2= the underlying data. Cast and Revenus are defined and using the logic found here: One
Revenue and Cost Caloulations

Revenue Sources:

= Projects
* Recurring

= Transzactional

Expense.

* Recurring (fixed)

= Variable iproject material costs, transactional costs, etc)

Revenus - Expense = Nat Profit
(Cash Forecast

The bostom graph of the One Dashboard, labeled “Cash Farecast” (Q0231), represents liquidity, and provides visibility into the current and forecast

pusitian of your company by leveraging the infarmation within Q350 as it pertains to bank account balances and expected receivables and payable
perind. Further detail on the information behind the Cash Forecast and the more detailed Cash FAow Forecast report can be found here: Cash Flow

12 s ok Lo Fonme

==L [

=] Report: Project Revenue / Cost Forecast

Report: QO0SE

Path: Live Data » Accounting » Project Revenue/Cost Forecast

Purpose:

The Project Revenue/Cost Forecast report, identified by the report number QD05E, serves as a critical tool within 0360, designed to provide insight into the
current state of existing projects in terms of both the revenue they have already earned and the revenue that is yet to be earned. Furthermore, it forecasts the
remaining cost and revenue month over month into the future, based on user-defined filter settings. This report is inwaluable for project managers and financial
analysts looking to make informed decisions about project performance and profitabilizy.

Benefits:

= Enhanced Project Visibility- The report provides a comprehensive view of each project’s current status, projecting both earned and projected revenue, enabling
stakeholders to gain a clear understanding of the financial health of individual projects

Accurgte Forecasting: The inclusion of forecasting methods (STRAIGHTLIMNE and MATLABCR (recommended)) allows for precise predictions of futurs cost and
revenue, crucial for making informed financial dedisions

Materizl Cost and Revenue Projection: By considering the Request Date and Purchase Order ETA date for material items, the report conservatively forecasts the
recognition of material costs and revenue, ensuring financial accuracy

Optimized Resource Allocation: The inclusion of Sold Hours, Remaining Hours, and Forecast Hours allows for a better understanding of labor resource
allocation and utilization, aiding in efficient project management

Detailed Profit Analysis: The report goes beyond revenue to calculate Gross Profit (GP) and Gross Margin {(GM), providing a comprehensive financial picture and
supparting profitability analysis

Periodic Forecasting: The ability to forecast data month over menth into the future helps in long-term planning. resource allocation, and revenue recognition,
SUpparting strategic decizion-making

Early Worning System: The Backlog and GP Backlog columns serve as early warning indicators, alerting stakeholders to projects where revenue recognition may
fall short of projections, allowing for timely corrective actions

Saoles Opportunity Integration: Incluzion of sales opportunity data allows for the forecasting of potential cost. revenue, and hours of active sales opportunities.
Users may customize the inclusion based on probability percentages

Forecasting Methods
Material Forecasting
Sales Opportunity Data
Sales Opportunity Filcers
Report Columns

Forecasting Methods

The Project Revenue/Cost Forecast report offers two distinct methods for forecasting cost and revenue: STRAIGHTLINE and MATLABOR (recommended). The
choice of forecasting method can be et as the default configuration—contact your Solutionz360 Professional Services or Customer Care t2am. Value for all
projects (unless explicitly denoted otherwise on the Project > Profit tab) uses the *PROJECTFORECASTMETHOD" configuration. Orptions for this configuration are:

in 2 period,
hods;

ryaur

ds give 2 mare
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Date in the
ATE and END
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